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Introduction 

This Job Aid is intended for Caseworkers, Case Planners, Case Managers, CPS 
Workers/Monitors and Foster/Adoptive Home Finders. The contents provide a detailed overview 
of the CONNECTIONS system changes due to the implementation of Build 18.9.  

With the implementation of Build 18.9, there will be several important changes that will improve 
the CONNECTIONS system. Specifically, this Job Aid contains information about: 

• the ability to change a Child Welfare Services Family Services Intake to an Advocates 
Preventive Only Family Services Intake 

• changes to Adding Outside Participants through the Family Services Stage window 

• a new button, Submit for Review, that introduces a new process that allows for a 
review of the FASP prior to formal submission for approval 

• an enhancement to the Check FASP Detail window that provides more details about 
incomplete components of the FASP 

• the ability to delete the Foster Care Discharge component of the FASP, if it was started 
in error 

• the ability to delete an Outcome and Activity Block 

• a new window that allows you to compare information between CONNECTIONS and 
WMS data  

• the ability to correct the Case Initiation Date (CID)after the initiation of the WMS 
application  

• an improvement to the Home Licensing window that allows a home to be designated as 
solely an Adoptive Home going through the approval process; and as distinguished from 
a home receiving an adoption subsidy  

In addition: 

• this Job Aid details changes to the CCRS Assessment and Service Plan data entry 
process. 

 

Any visible identifying data 
in this Job Aid is simulated. 

 

 

This Job Aid assumes familiarity with the 
CONNECTIONS System. 

 
This job aid is available online: 

• On the CONNECTIONS Intranet site: 
DFA Intranet Site > OCFS Home page > CONNECTIONS >Desk and Job Aids 

The CONNECTIONS Intranet site also contains information about CONNECTIONS training. 
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The Assigned Workload 

The Assigned Workload includes a new column. The Agency column displays the three digit 
agency code of the Case Planner. This distinguishes with which agency a certain case is 
associated with.   

Changing the Type of Service being Requested for an FSI 
that Originated from an Unfounded Investigation  

Currently, in New York City when a Family Services Intake (FSI) 
is created as a result of an unfounded Child Protective Services 
(CPS) Investigation you do not have the ability to change the 
case type from Child Welfare Services (CWS) to Advocates 
Preventive Only (ADVPO). With the Implementation of Build 
18.9, you will be able to change the case type for unfounded 
investigations. Once your Supervisor approves the investigation 
conclusion and the FSI is on your assigned workload, you can 
navigate to the Narrative tab of the FSI and a new option of 
(ADVPO) Advocates Preventive Only displays under the Service Type drop down field. By 
selecting this field you have the ability to change this case type from CWS to ADVPO. 

 

 

Step-by-Step: 
Changing an FSI from a Child Welfare Services (CWS) Case to an Advocates 
Preventive Only (ADVPO) Case  

1 From the Assigned Workload, select the appropriate FSI stage. 
The Task button enables. 

2 Click on the Tasks button. 
The Family Services Intake Window displays. 

3 Click on the Narrative tab. 
The Narrative tab displays. 

4 Click on the Type of Services being requested drop 
down field and select (ADVPO) Advocates Preventive 
Only. 
The Save button enables. 

 
In order for the FSI to be 
created on your Assigned 

Workload upon its approval, the 
Closure Reason must be Case 

open-Services  

 
To be able to modify the Type of 

Service being requested the 
CPS Investigation that the FSI 

originated from must be 
Unfounded.  

5 Click on the Save button. 
 

CONNECTIONS – Critical Improvements System Build 18.9 Job Aid –v1.0 (04/02/2007) Page 3 



 

Enhancements to Check FASP Detail and Check Removal 
Detail 

Each FASP, Removal Update or Plan Amendment contains multiple components that are 
required to be completed before a FASP is submitted for approval. At any time during the 
completion of a FASP, you can click on the Check FASP Detail button to determine if all 
required components are complete and ready for submission. Prior to the implementation of 
Build 18.9, when you clicked on the Check FASP (or Check Removal) Detail button, a list of 
incomplete components would display. You would then need to navigate back to the FASP 
component in order to identify which tab was incomplete and for which child. This was often 
seen as challenging, depending on the component and the number of children in the stage. 

With the implementation of Build 18.9, there will be two new enhancements to the Check FASP 
and Check Removal Detail process. When a FASP component is incomplete, you will be 
directed back to the component as well as the specific tab within the incomplete component. 
When the incomplete component is a subnode within Foster Care Issues, you will be directed 
back to the component as well as the specific tab and child.  
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In addition, Build 18.9 introduces the ability to print a Check FASP Detail Report. This report will 
include: 

• The name and ID associated with the case 

• The Stage ID and name of the stage  

• The Case Initiation Date (CID) 

• The date the report was generated  

• The Local District responsible for case planning, and  

• A list of all incomplete component messages that appear in the listbox on the Check 
FASP Detail window. 

 

Step-by-Step: 
Printing the Check FASP Detail Report 

1 On the Family Assessment and Service Plan window, click on the Check FASP 
Detail button. 
The Check FASP Detail Component Status window displays. 

2 To view the Check FASP Detail Report, click on the Reports 
menu. 
The Incomplete FASP Component List displays in the sub-
menu. 

3 Click on the Incomplete FASP Component List. 
The Check FASP Detail Incomplete Component Listing Report 
displays similar to a word document. 

4 Click on the Print All button.  

The FASP Review Process 

The Family Assessment and Service Plan (FASP) provides a uniform and effective method for 
you to document your assessment of family and child functioning, strengths and needs. 
Ongoing assessment of a family receiving services is important in achieving the goals of safety, 
permanency and well-being for children. 

 
Where am I? 

Assigned Workload > FSS > 
Tasks > FASP tab  

 
With the implementation of Build 

18.9, you will also be able to 
submit a Plan Amendment and 

Removal Update for supervisory 
review using the Submit for 

Review button. 

The Case Planner (or Case Manager acting as the Case 
Planner) is responsible for completing and submitting the FASP 
for approval in the necessary time frames. With the 
implementation of Build 18.9, a new button, Submit for Review, 
introduces a new process that allows for supervisory review of 
the FASP prior to a formal submission for approval. 

Although this is an optional process for Case Planners (or case 
Manager acting as Case Planner), it is designed to assist with 
supervisory feedback and can aid in the timely approval of a 
FASP. This process allows the Case Planner (or Case Manager 
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acting as Case Planner) to submit an In-Process FASP to his/her Supervisor/Unit Approver. The 
Supervisor/Unit Approver can make corrections to a modifiable FASP Report. The FASP Report 
is similar to a word document, allowing for revisions and corrections to be inserted. These 
changes within the document display on the screen in red. Information deleted from the report 
will display with a red strike-through. The Case Planner (or Case Manager acting as Case 
Planner) is able to copy and paste these corrections from the document into the specific FASP 
window or windows as directed by their Supervisor/Unit Approver.  

All components of the FASP must be completed before it can be submitted to the 
Supervisor/Unit Approver for review. When all Check FASP submission edits have been 
completed, the Submit for Review button enables at the footer (bottom) of the Check FASP 
Detail Component Status window. When the Submit for Review button is clicked a To-Do is 
generated and sent to the Supervisor/Unit Approver. The Supervisor/Unit Approver can navigate 
from this To-Do to the FASP Output Report where he/she can insert comments and/or make 
revisions. When a FASP is submitted for review, it remains in In-Process status, allowing the 
Case Planner (or Case Manager acting as the Case Planner) to continue to work on the FASP. 

Some things to keep in mind when submitting a FASP for review: 

• A FASP can be submitted for review more than once, if necessary. 

• When the FASP is submitted for review, it can only be sent to the first level 
approver. For example, if the stage has a Local Department of Social Services 
(LDSS) Case Manager, a voluntary agency Case Planner, and a voluntary 
agency Caseworker, only the Case Planner may submit the FASP to their Unit 
Approver/Supervisor for review. 

• Throughout this review process, the FASP remains In-Process. 

• If you make changes to the FASP during the period that your supervisor is 
reviewing it, the FASP should be re-submitted for review. 

 

Page 6 CONNECTIONS – Critical Improvements System Build 18.9 Job Aid –v1.0 (04/02/2007) 



  

 

 

Step-by-Step: 
Submitting a FASP for Review 

1 On the Family Assessment and Service Plan 
window, click on the Check FASP Detail button. 
The Check FASP Detail Component Status window 
displays. 

2 Click on the Submit for Review button. 
The Family Assessment and Service Plan window 
displays. 

 
 

 

 

 

 

 
 
Supervisory Review of the FASP 
Once a Case Planner (or Case Manager acting as the Case Planner) submits a FASP for 
review, a navigable task To-Do is created on the Supervisor/Unit Approver’s To-Do list window. 
The Supervisor/Unit Approver uses the To-Do to navigate directly to the FASP Report. This 
should be done in a timely manner so that the FASP can be sent back to the submitter and 
corrections can be completed. 

 
Where am I? 

Assigned Workload > FSS > 
Tasks > FASP tab  

 
When you submit a FASP for 

subsequent review the following 
message displays: “FASP/Plan 

Amendment has been submitted 
for review. All comments 

associated with the review will 
be lost, and review process will 
be discontinued. Do you wish to 

continue?” 

 
Only the Supervisor/Unit 

Approver has the authority to 
make corrections within the 

FASP Report. 

The FASP Output Report displays in a modifiable form, similar 
to a Microsoft Word document. The Supervisor/Unit Approver is 
able to review the document and make comments, suggestions 
or corrections directly within the document. All comments or 
revisions will be displayed on the FASP Report in red. 
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Once a Supervisor/Unit Approver has completed reviewing the FASP Report, they will mark the 
FASP review complete by using one of the following two checkboxes: Review Complete with 
Comments or Review Complete with no Comments. If the Supervisor/Unit Approver has 
inserted comments or suggestions, the Review complete with Comments should be checked. 
When the Supervisor/Unit Approver has reviewed the document and has not inserted comments 
or corrections the Review Complete with no Comments checkbox should be checked. Once a 
Supervisor marks the FASP Review as complete and clicks on the Save button, a navigable 
task To-Do is created on the Case Planner’s (or Case Manager acting as Case Planner) To-Do 
list window. The Case Planner (or Case Manager acting as the Case Planner) uses this To-Do 
to navigate directly to the FASP Report and review the changes made by the Supervisor/Unit 
Approver. 

 

Step-by-Step: 
Supervisory Receive/Review FASP 

1 Click on the To-Do button on the CONNECTIONS 
Toolbar. 
The Staff To-Do List displays. 

2 Select the To-Do with the description “FASP Ready 
for Review.” 
The Navigate and Detail buttons enable. 

3 Click on the Navigate button. 
The FASP Report displays in modifiable format. 

4 Scroll through each section of the FASP report and make necessary corrections. 
Deleted text will appear in RED. 

5 Select the Review Complete Comments checkbox or the Review Complete No 
Comments, whichever is appropriate. 
A checkmark displays in the checkbox. 

6 Click on the Save button. 
The FASP report closes. A To-Do is assigned to the 
submitter and contains the following description 
“FASP Review Complete with Comments or FASP 
Review Complete No Comments.” 

7 Click on the Close button. 
The CONNECTIONS Toolbar displays. 

 
Where am I? 

CONNECTIONS Toolbar > Staff 
To-Do list > FASP report 

 
A Supervisor can save the 
FASP without marking it 

complete, and work on it at a 
later time if needed 



  

Copying and Pasting the FASP Report with Supervisory Comments 
You have the ability as a Supervisor/Unit Approver to copy the entire FASP Report that contains 
your comments and paste into a word document. If you want to maintain a hard copy of the 
FASP Report with your comments for your files this allows you to produce the FASP Report as 
a word document and print for your records. 

 

Step-by-Step: 
Copying and Pasting and Entire FASP Report With Comments 

1 With a separate word document open and minimized on your computer, navigate 
from the Staff To-Do list to the FASP Report that includes your comments or 
revisions. 

2 Highlight the entire FASP Report with comments by clicking near the text and 
dragging your cursor over the text while holding down the left mouse button.  

3 Hold down on the Ctrl and C keys together on your keyboard, or use the copy button 
to copy the entire report. 

4 Navigate to the word document and hold down the Ctrl and V keys to paste the 
entire report. 
The entire FASP Report displays. 

 

Completing Corrections within the FASP 
Once the Supervisor/Unit Approver completes the review of the FASP and marks it complete 
(with or without comments) the Case Planner (or Case Manager acting as the Case Planner) 
will receive a Task To-Do on his/her To-Do List. The description of the Task To-Do will vary, 
depending on whether or not the review included comments. If the Supervisor/Unit Approver 
marked the Review Complete with Comments, the following will display in the description field 
for the Task To-Do: 

“FASP review has been completed with comments.” 

If the Supervisor/Unit Approver marked the Review Complete with no Comments, the following 
will display in the description field for the Task To-Do: 

“FASP review has been completed with no comments.” 

In order to make changes requested by the Supervisor/Unit Approver, you must navigate to the 
FASP window then you access the FASP report from the Task To-Do and open the 
corresponding FASP components. You are then able to toggle back and forth between the 
FASP report and the FASP windows to make the necessary changes. To incorporate the 
comments made by the Supervisor/Unit Approver, you will be able to copy and paste the text 
between the FASP report and the FASP windows.  
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Step-by-Step: 
Completing Corrections within the FASP 

1 Navigate to the In-Process FASP report to which you 
are making corrections to. 

2 Scroll to the section that has comments.  

3 To copy and paste comments, highlight the 
comments made by the Supervisor/Unit Approver. 

4 Hold down on the Ctrl and C keys together on your 
keyboard, or use the copy button to copy the text. 

5 Click on the Assigned Workload button on your task 
bar at the bottom of your Citrix window. 

6 On the Assigned Workload, click on the appropriate 
stage. 

7 Click on the Tasks…button. 
The Family Services Stage window displays. 

8 Expand the FASP Tree and click on the appropriate sub node where corrections 
need to be inserted. 

9 Press on the Ctrl and V keys together on your keyboard to paste the text. 
The copied text displays. 

10 To delete comments indicated by the Supervisor/Unit 
Approver, highlight the specific text that you wish to 
delete. 

11 Press on the Delete key on your keyboard. 
The Save and Cancel buttons enable. The 
highlighted text is now deleted from the narrative. 

12 Click on the Save button. 

13 Click on the Close button. 
The Family Assessment Service Plan window displays. 

 
Where am I? 

Assigned Workload > Tasks > 
FASP tab >  

 
In order to move back and forth 
between the two windows, you 
must open the FASP window 

before opening the FASP report 
from the To-Do list 

 
To toggle back and forth 

between your FASP report and 
the FASP windows simply click 
on the CONNECTIONS Toolbar 

(FASP Report) button on the 
task bar located at the bottom of 

the screen. 
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New Features in CONNECTIONS 

When completing the narrative section of reports (including FASP Reports) or when printing 
Progress Notes, the Find button displays. Clicking on the Find button displays the Find window 
which allows you to search for specific words within the report. Within the Find window you can 
select the Find Next button to search for each subsequent word; you also can select the Up or 
Down radio buttons to move up and down through the report. The Match case checkbox is 
selected when the Find window displays. A Match case search will find the word in the report as 
it is exactly entered in the field. For example, if the word “worker” is entered, the system will only 
find the word “worker” in the report, the term “Worker” will not return any results. To find a word 
without using Match case, click on the checkbox to deselect the checkmark. 

 
Two new text tools have been added to all windows where text tool control features already 

exist. The Search  and Replace  buttons will aid you in completing the narrative piece of 

the report. Clicking on the  displays the Find window and clicking on the  displays the 
Replace window. This tool allows you to select a word in the report and replace with a different 
word. You have the option of replacing just one specific word by clicking on the Replace button, 
you can also click on the Find Next button to replace some or even all the words, or you can 
click on the Replace All button to replace all occurrences of the word within the report. The 
Cancel button also displays on the Replace and Find window.  
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Printing the Approved FASP Report 

Once a FASP has been approved by the Supervisor/Unit Approver you have the option of 
printing the report. As mentioned earlier, with the implemented changes of Build 18.9, new 
buttons display at the bottom of the FASP report as options for printing the report. Selecting the 
Print All button will print the entire FASP report for you to view all components of the FASP. 
Clicking on the Print Selected button displays the FASP Report Components window. All 
components of the FASP report are listed on this window so you can select which components 
you wish to print.  

Comparing WMS –CONNECTIONS Data in CONNECTIONS 

When a new FSS/CWS, FSS/CCR or FSS/ ADVPO stage is created in CONNECTIONS, it is 
necessary to create the companion WMS case; this process is 
called Application Registration. Once you select a Primary 
Caretaker in the FSS stage in CONNECTIONS, the WMS App 
Reg button on the Family Services Stage window Stage 
Composition tab becomes enabled. With the implementation 
of Build 18.9, you will need to be assigned a new Business 
function MAIN APP REG to initiate the opening of the 
companion WMS case. If you are assigned the MAIN APP 
REG Business Function the following message will display 
upon clicking the WMS App Reg button: “XX/XX/XX will be the 
effective start date for the services case in WMS. Payment 
may not precede this date.” If you are not assigned the MAIN 
APP REG Business Function, upon clicking the WMS App Reg button you will receive the 
following message: “Appreg can be conducted only by individuals with AppReg BF.” 

 
Only workers who have the 
MAIN APP REG Business 

Function will be able to initiate 
the application registration 

process in WMS for child welfare 
cases open in CONNECTIONS. 

 
Demographic information recorded and saved in CONNECTIONS automatically transfers to 
WMS during the interface process. The interface allows basic demographic information about 
individuals listed on the Family Services Stage window Stage Composition tab in 
CONNECTIONS to be compared for a match in WMS. Demographics can only be recorded and 
modified in CONNECTIONS. 

The hierarchy of information continues to exist between WMS Services and Non-Services 
records. Data does not change in WMS Services if it does not agree with information in an 
active Non-Services case (e.g., Temporary Assistance, Medical Assistance, Food Stamps). If 
there are existing WMS Non-Services and Services cases associated with the FSS, when data 
is modified in CONNECTIONS it may case WMS and CONNECTIONS to be out of synch; the 
WMS Synch button (on the Stage Composition tab in CONNECTIONS) remains enabled until 
the differences are reconciled. The WMS Synch button will also enable when the data between 
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WMS and current CONNECTIONS data remain the same, when a “WMS Cancel” transaction 
occurs in WMS. 

Prior to the implementation of Build 18.9 you would have to review demographic information in 
both CONNECTIONS and WMS to determine what information was out of synch. The 
implementation of Build 18.9 introduces the Compare WMS CONNECTIONS Data window. This 
window will allow you to view and compare the current demographic data contained in both 
WMS and CONNECTIONS in a single location. You will be able to access the Compare WMS 
CONNECTIONS Data window by clicking on the Options menu on the Family Services Stage 
window and selecting Compare WMS CONNECTIONS Data. The Compare WMS 
CONNECTIONS Data window contains two sections: the Existing WMS Data and the Current 
CONNECTIONS Data. If the WMS Synch button enabled due to a cancelled transaction, the 
following message will display on the Compare WMS – CONNECTIONS Data window: 

“WMS Synch enabled due to a WMS Cancellation transaction. Confirm with WMS user and 
validate CONNECTIONS data.” 

You will not be prompted with a message when the Case Manager Office, Unit or Worker codes 
differ on the Compare WMS CONNECTIONS Data window. You will have to view each code to 
verify any differences.  

 

The Compare WMS CONNECTIONS Data window is divided into the following sections: 

• Header 

• Grids 

• Footer 

The header is always visible and includes the Case Name, Case Initiation Date and WMS Case 
number, as well as File, and Help menus. The Case Name, Stage ID number and Case ID 
display in the title bar. The footer on the window contains the Close button. 



 

The Existing WMS Data  
The Existing WMS Data section contains Caretaker (Payee) Name and address, Case Manager 
Office, Unit and Worker; as well as the following columns: 

Person ID The person’s unique, CONNECTIONS system-system generated 
identification number. 

First Name The first name of all individuals included in a case as recorded in WMS. 

Middle Name The middle name of all individuals included in a case as recorded in WMS. 

Last Name The last name of all individuals included in a case as recorded in WMS. 

Suffix The suffix (if applicable) of all individuals as it is recorded in WMS. 

Sex The gender of all individuals as recorded in WMS. 

DOB The Date of Birth of all individuals as recorded in WMS. 

SSN The Social Security Number of all individuals as recorded in WMS. 

The Current CONNECTIONS Data  
The Current CONNECTIONS Data section contains Caretaker (Primary) Name and address, 
Case Manager Office, Unit and Worker and the following columns: 

Person ID The identification number of the person as recorded in CONNECTIONS. 

First Name The first name of all individuals included in a case as recorded in 
CONNECTIONS. 

Middle Name The middle name of all individuals included in a case as recorded in 
CONNECTIONS. 

Last Name The last name of all individuals included in a case as recorded in 
CONNECTIONS. 

Suffix The suffix (if applicable) of all individuals as it is recorded in 
CONNECTIONS. 

Sex The gender of all individuals as recorded in CONNECTIONS. 

DOB The Date of Birth of all individuals as recorded in CONNECTIONS. 

SSN The Social Security Number of all individuals as recorded in 
CONNECTIONS. 

Events The Events column indicates whether or not information has been modified 
added or deleted within CONNECTIONS or indicates whether there is no 
change. 
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Step-by-Step: 
Comparing WMS and CONNECTIONS Data 

1 Click on the Options menu on the Stage 
Composition tab. 

2 Select Compare WMS CONNECTIONS Data. 
The Compare WMS CONNECTIONS Data window 
displays. 

 

 

Recording and Updating the Application Date 

Sometimes the Date of Application, which is one of the Case Initiation Date (CID) trigger dates 
is recorded incorrectly in CONNECTIONS. Prior to the 
implementation of Build 18.9 if the Date of Application was 
recorded in the Family Services Intake (FSI) it could not be 
modified in the Family Services Stage (FSS). Since the CID 
establishes the due dates for all FASPs the due dates of the 
FASPs may have been incorrect. In addition the WMS 
opening date is also established based on the CID and could 
not be corrected in WMS.  

Build 18.9 introduces a new field on the FASP window 
Corrected Application Date. This new field will allow you to 
record a corrected application date, if the Date of 
Application was recorded incorrectly in the FSI.  

Recording a date in the Corrected Application Date field (if 
it is now the earliest of the four CID trigger dates) and clicking on the Save button will update 
the CID due date and FASP due dates and the WMS start date. The WMS start date will only be 
updated if Full Data Entry (FDE) has not yet been started, or has been cancelled. If FDE has 
begun or been completed, the FASP due dates will be updated but the WMS start date will not 
be updated. This field will only be modifiable until the initial FASP is approved or the 
comprehensive FASP has been launched. In order to change the Application Date to an earlier 
date when FDE has begun and/or the initial FASP has been approved, you must close the WMS 
case and the FSS stage and then re-open the case.  Once the WMS case has been opened 
and/or the initial FASP has been approved or the comprehensive FASP has been launched, in 
order to change the WMS case opening date, you must close the WMS case and the FSS stage 
and then re-open the case. For more detailed information, refer to the WMS Interfaces Job Aid. 

 
Where am I? 

Assigned Workload > Tasks > 
Stage Composition tab 

 
Any changes to the CID will 
update the WMS Application 

Date as long as the application 
is in AVAIL status. Once FDE 
begins, modification to any of 
the four trigger dates in the 
FASP will not update WMS 

Application Date. Thus, 
CONNECTIONS CID and WMS 

start date will be different. 
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A new message will be added with the implementation of Build 
18.9 to advise workers what the start date for the WMS case will 
be; upon clicking the WMS App/Reg button the following 
message displays: 

“xx/xx/xxxx will be the effective start date for the services case in 
WMS. Payment may not precede this date.  

The worker will click on the OK button to continue. 

 

 

 
All dates entered must be in 

valid format. No dates can be 
selected prior to 6 months 

before the CONNECTIONS 
stage was opened. 



  

The CID for an FSS is calculated using the earliest of four trigger dates. The following fields 
display in the CID Trigger Dates section: 

Date of 
Application 

This is the date the application for services (signed by the parent or, if 
the parent refuses to sign, the Caseworker) was received by the Local 
District/ACS. Any worker with a role in the stage can modify this date 
prior to the approval of the Initial FASP, unless this date was recorded 
during the FSI. 

Date of 
Indication 

This view-only field displays the date the Indicated CPS Investigation 
Conclusion was approved. 

Date of Court 
Order 

This field represents the date of the court order for services. Any 
worker with a role in the stage can modify this date until the approval 
of the Initial FASP. 

Date of 
Placement 

This case-specific field reflects the date the first child initially entered a 
foster home or facility. Any worker with a role in the stage can modify 
this date until the approval of the Initial FASP.  

Corrected 
Application 
Date 

This is a new field in CONNECTIONS. It allows you to enter a 
corrected date of Application if the date entered within the FSI is 
incorrect. This will in turn recalculate the FASP due date accordingly. 

 

It is important to note that none of the above dates can be modified once the Initial FASP is 
approved or the comprehensive FASP has been launched. 

The field below displays the CID Trigger Dates section: 

Next FASP Due 
Date (based on 
the CID) 

This view only field, which reflects the due date of the next FASP, is 
system populated when you access the FASP. When a date is 
recorded and saved in the Corrected Application Date field, the Next 
FASP Due Date is recalculated.  
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Step-by-Step: 
Updating an Incorrect Date of Application  

 
Where am I? 

Assigned Workload > Tasks > 
FASP tab 

 
You are only able to complete 
this if the initial FASP has not 

been approved or the 
comprehensive FASP has not 

been launched. WMS is affected 
only if FDE has not begun or if 

begun, is cancelled and the 
application is returned to AVAIL 

status. 

 
If NYC workers do not select the 

Confirm PL checkbox, the 
following message displays in 
red at the bottom of the Stage 

Composition tab “Primary 
Language has not been 

confirmed for one or more 
individuals in the stage.” 

1 On the Family Assessment and Service Plan window, 
Record the correct application date in the Corrected 
Application Date field. 
The Save and Cancel button enable. 

2 Click on the Save button. 
The corrected CID displays and the recalculated Next 
FASP Due Date displays. The following message 
displays in the footer of the Family Assessment and 
Service Plan window: “CID has changed. Check 
FASP due date.” 

3 Click on the Close button. 
The Assigned Workload displays. 

 

 

Confirm Primary Language 

The Confirm PL is a new column that displays on the Stage 
Composition tab. You can select Yes or No from the dropdown 
field to confirm the primary language for that individual only 
when the person is part of a CPS or FAD stage. When this 
checkbox is selected, “Yes” is displayed in the Confirm PL 
column on the Stage Composition tab (Family Services Stage 
window); conversely, a checkmark will automatically display on 
the Person Detail window in this checkbox when you select 
“Yes” from the Confirm PL column on the Stage Composition 
tab.  
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Add Outside Participants 

There are various times while working in a Family Services Stage (FSS) that you need to record 
information about a person who is not part of the stage composition. For example, when you are 
preparing Visiting Plans or scheduling Service Plan Reviews, outside participants need to be 
involved and so listed on CONNECTIONS. This is done by clicking on the Add Outside 
Participants button within the Visiting Plan tab in the Visiting Plan window and the Persons 
tab in the Service Plan Review Details window. With the implementation of Build 18.9 workers 
will also need to record information about people who are not part of the stage composition but 
should receive the Permanency Hearing Report and/or receive Notice about the permanency 
hearing.  

To add an outside participant for the purpose of a Permanency Hearing, you will navigate to the 
Outside Participants window by selecting the Options menu and the Add Outside Participants 
command from the Family Services Stage window.  

 

 



 

With the implementation of Build 18.9, the Outside Participants window introduces a new field 
called the Interest field. The Interest field refers to the role the person has in relationship to the 
family. When the Outside Participants window is accessed using the Add Outside Participants 

command from the Stage Composition tab, the Interest field is enabled and required. You 
must select one and only one Interest for each person entered. The following will display to 

complete the Interest field: 

• Sibling 

• Half Sibling 

• Step-Sibling 

• Step-Parent 

• Great Grandparent 

• Grandparent 

• Aunt/Uncle 

• Niece/Nephew 

• Cousin 

• Other Family 
Member 

• Legal Guardian 

• Legal Custodian 

• None 

• CASA Volunteer 

• Caseworker 

• Foster Child 

• Foster Parent 

• Guardian 

• Law Guardian 

• Other 

• Other 
District/Agency 
Staff 

• Parent/Guardian 
Attorney 

• Pre-adoptive 
Parent 

• Probation 

• Relative 

• School Personnel 

• Service Provider 

• Third Party 
Reviewer 

• Tribal 
Representative 

• Qualified Expert 
Witness 

• Former Foster 
Parent 

• Other Suitable 
Person
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Step-by-Step: 
Adding an Outside Participant via the Family Services Stage Window 

1 On the Family Services Stage window, click on the 
Options menu and select the Add Outside 
Participants command. 
The Outside Participants window displays. Any 
outside participants who were previously added to 
the stage display in the list section. Required fields 
highlight in yellow. 

 
Where am I? 

Assigned Workload > Tasks > 
Tasks 2 Record the person’s name in the Last Name and 

First Name fields. 
3 In the Interest field, click on the drop-down arrow and select the individual’s interest 

from the resulting list 
4 In the Agency field. Type in the name of the individual’s agency, if applicable. 
5 In the Participant Address section, record the individual’s address in the appropriate 

fields. 
6 When you have recorded the address, click on the Validate button. 

The Address Validation window displays. 
7 Click on the Accept button to accept the validated address, as applicable. 
8 Record phone, fax and e-mail information in the respective fields; as applicable. 
9 When you are finished recording information for this person, click on the Add button. 

The information is added to the Outside Participants list. 
10 Click on the Save button. 
11 Click on the Close button. 

The Family Services Stage window displays. 
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Step-by-Step: 
Modifying an Outside Participant via the Family Services Stage Window 

1 On the Family Services Stage window, click on the 
Options menu and select the Add Outside 
Participants command. 
The Outside Participants window displays. Any 
outside participants who were previously added to 
the stage display in the list section. Required fields 
highlight in yellow. 

 

2 Select the person you wish to modify from the 
Outside Participants list. 
The selected person’s information populates the data fields. 

If you make changes to any of 
the address fields, you must 

click on the Validate button and 
validate the address. 

3 Make any necessary changes in the respective fields. 
4 When you have finished recording information for this individual, click on the Modify 

button. 
5 Click on the Save button. 

 

 

Step-by-Step: 
Deleting an Outside Participant via the Family Services Stage Window 

1 On the Family Services Stage window, click on the Options menu and select the 
Add Outside Participants command. 
The Outside Participants window displays. Any outside participants who were 
previously added to the stage display in the list section. Required fields highlight in 
yellow. 

2 Select the person you wish to delete from the 
Outside Participants list. 
The selected person’s information populates the 
data fields. 

 
When you navigate to the 

Outside Participants list through 
the Family Services Stage 

window you can only delete a 
person that was added using 
the same navigational path. 

3 Click on the Delete button. 
The selected person’s information is deleted from 
the Outside Participants list. 

4 Click on the Save button. 

The outside participant is not 
deleted until you click on the 
Save button. If you cancel 

before saving, the person will 
reappear on the Outside 

Participants list. 
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Deleting Discharges 

Discharge planning begins as soon as a child is placed in foster care. Foster care is intended as 
a temporary solution; the ultimate goal is the achievement of the child’s safety and well-being in 
a permanent home with permanent attachments and relationships. Discharge information must 
be recorded for each child who is discharged from foster care.  When a child is discharged from 
Foster Care, you must complete the discharge information in either a FASP or a Plan 
Amendment. 

Prior to Build 18.9, if you mistakenly began recording discharge information for a child or 
selected the wrong discharge for a child there was no way to “back out” and select the proper 
protocol. You had to complete the discharge component for all edits so the FASP could be 
submitted; this caused incorrect information to become 
part of the completed FASP.  

 
With the implementation of Build 18.9, you will be able to 
delete a Discharge that was recorded incorrectly. If you 
have recorded incorrect Discharge information for a child, 
you are able to delete the information from the Discharges 
window by clicking on the Options menu, and selecting 
the Delete Protocol option. When you select the Delete 
Protocol option, the following message will display: 

When a discharge protocol is 
deleted, it is deleted for all 

children in a stage, not just the 
selected child. 

“This Discharge information will be deleted for all children. Do you wish to continue? 

Clicking the Yes button will delete the selected discharge protocol information and the label for 
the deleted protocol will update to New. If the worker selected the incorrect discharge type they 
can select the appropriate discharge and complete the protocol. Selecting the No button will 
bring the worker back to the Discharges window. Selecting the Close button closes the 
Discharges window. 
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Step-by-Step: 
Deleting a Discharge  

1 On the Discharges window, click on the Options 
menu, select the Delete Protocol command and 
click on the enabled sub-menu command 
(Home/Relative/Other Caretaker, Independent Living, 
or Adult Residential Care).  
The following message displays “This Discharge 
information will be deleted for all children. Do you 
wish to continue?”  

 
Where am I? 

2 Click on the Yes button. 
The deleted protocol is deleted and the In-Process Button is updated and labeled 
NEW.   

Assigned Workload > FSS > 
Tasks > FASP tab > FASP Tree 

> Discharge node 

 

Changes to the Outcome and Activity (O&A) Block  

The Service Plan window contains the Outcome and Activity (O&A) Index. This term is used to 
describe a cluster of problem/concern statements that specify the behavior, the underlying 
condition or circumstance that needs to change, the services that will support that change, and 
statements of the desired result/outcome of that change. Outcome and Activity Blocks are 
carried forward from previous FASPs. You can modify and update rather than record a new 
Block. 

Deleting an Outcome and Activity Block 
Prior to the implementation of Build 18.9, if an O&A Block was recorded in error you were 
unable to delete the entire O&A Block. This caused erroneous information to become part of the 
completed FASP.  

With the implementation of Build 18.9, you will be able to delete an O&A Block that was created 
during the current In-Process FASP. If an O&A Block is carried over from a previous FASP, you 
will not be able to delete it.  For example, if you are working on the Reassessment FASP and 
select an O&A Block that was added during the Comprehensive FASP you will not be able to 
delete it because the block was added during a previous FASP. 

When you select the Delete O&A Block item the following message will display: 

“The selected O&A block will be deleted from the Service Plan. Do you wish to continue? 

Clicking the Yes button, closes the message, the selected O&A block is deleted from the 
Service Plan and the Service Plan window is refreshed and remains open. Clicking the No 
button closes the message window. No information is deleted from the Service Plan and the 
Service Plan window remains open.  
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Step-by-Step: 
Deleting an O & A Block  

1 On the Service Plan window, click on the box to the 
left of the Outcome and Activity Block that you want 
to delete. 

 2 Click on the Options menu and select the Delete 
O&A Block command.  
The following message displays “The selected O&A 
block will be deleted from the Service Plan. Do you 
wish to continue?” 

Where am I? 

3 Click on the Yes button 
The deleted O&A Block is no longer included on the index. 

Assigned Workload > FSS > 
Tasks > FASP tab > FASP Tree 

> Service Plan node 

New Status on the Outcome and Activity Index 
The Outcome and Activity Index display active and inactive blocks. The index will display only 
active blocks when you select the View Active radio button however, all blocks display, 
including inactive blocks when you select the View All radio button. Active blocks include those 
with a status of: 

• New – An O&A Block created in the current FASP or a block created in a prior FASP but 
not yet market as retained, achieved or discontinued (you must change the status of a 
block from a prior FASP to retained before you can submit the Service Plan) 

• Retained – An O&A Block carried over from a prior FASP that a worker has actively 
marked as “retained” with the current FASP 

• Modified – An O&A Block from a prior FASP that has been modified in the current 
FASP; can also be a block that was modified in a Plan Amendment 

Inactive blocks include those with a status of: 

• Achieved – indicates that the block’s desired outcome has been successfully achieved  

• Discontinued – indicates that this block is not longer applicable for the current stage 

The inactive blocks include a new status: 

• Ended – Closing Stage – this is a new status that indicates that the block has been 
deleted as a result of the stage being closed 
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Adoption Subsidy Dual Purpose Home 

Certification or approval of a foster home includes recording all required licensing information 
the F/A Home License window. This window is closely tied to the Foster and Adoptive Home 
Record Summary (FRS), and other windows in CONNECTIONS. Information recorded in this 
window (as well as other windows in the FAD stage) displays in the FRS. 

The Subsidy Checkbox 
Prior to the implementation of Build 18.9 when a Foster Parent adopted a child, LDSS FAD 
workers had to create a “new” Adoptive Home in CONNECTIONS to pay a subsidy, even 
though the Foster Parents already had an open Foster Home in CONNECTIONS. This was 
done so the adoptive parents could receive adoption subsidy. Build 18.9 introduces a new 
feature to the F/A Home License window, the Subsidy checkbox. LDSS FAD workers will be 
able to select this checkbox when a resource family wishes to remain open to foster or adopt 
other child(ren) and also receives an adoption subsidy. This will be referred to as a Dual 
Purpose Home. Voluntary Agency staff cannot use the checkbox, as they are never responsible 
for paying a subsidy. The Subsidy checkbox will also allow access to the Foster Care vendor ID 
for point of service (POS) lines written for Adoption Subsidy services. The following are other 
changes that will take place for Adoptive homes: 

• A new facility type of “Adoption Subsidy Home” will be added under the Setting of 
Adoption. This will allow you to differentiate between resources seeking approval to 
adopt children and those only open to receive a subsidy.  

• With the Implementation of Build 18.9, the Facility Type of “Adoptive Home” will be used 
to identify a resource as seeking approval to adopt children. 

• For the setting of “Adoptive” the “Auth-To” date field will be blank and the Home Closure 
batch will no longer close the Adoptive home after one year (no reauthorizations are to 
be done). 

• If you are a worker assigned to this case, you will receive a new alert notifying you that 
the foster care portion of the home has closed. Other alerts and events will also be 
generated to assist you in managing these cases.  

• When an “Adoptive” home is closed (through manual closure), the “To Date” is updated 
with the date of home closure. 

• If the foster care certification/approval lapses in a dual purpose home due to a failure to 
reauthorize, the home will automatically convert to a Setting of Adoption and a Facility 
Type of Adoption Subsidy Home.  

• You will be allowed to change the Setting and Facility Type back if you wish to reopen 
the foster care portion. 

However, Local Districts still have the option to create a separate new Adoptive home, using a 
local assigned Vendor ID. 

Adoptive (accepted active status) and Foster (both emergency and accepted active statuses) 
homes being submitted for approval should have all family members recorded in the Stage 
Composition and at least one person must have the name of at least one foster or adoptive 
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parent identified. Marital Status, Date of Birth, Ethnicity, Gender, Religion, and Language 
information must be entered for all persons in a foster and adoptive home. 

For Adoption Subsidy Homes, with the setting of “Adoptive”, the Auth-To date field will be blank 
and the Home Closure batch will no longer close an Adoptive home after one year (no 
reauthorizations are to be done). 

 

Changes to CCRS regarding data entry 
of Service Plans 

In an effort to provide relief to users who are currently 
entering duplicative information into both CCRS and 
CONNECTIONS, a change will be implemented in February 
2007 which will make CONNECTIONS the only system used 
to record Assessment and Service Plan data. Users will no 
longer be required and CCRS will no longer permit the 
recording of Assessment and Services Plans in CCRS.  

 

The system of record for the CID and Assessment and 
Service Plans will be CONNECTIONS. CONNECTIONS will replace the CCRS Assessment and 
Service Plan functionality. Although CCRS will no longer be used to record Assessment and 
Service Plans, Local Districts must continue to register the case in CCRS; as CCRS remains 
the system of record for placement/movement, legal and 
adoption activities. CCRS will also continue to provide 
information to the Adoption Monitoring System (AMS). 

If a FASP was completed in 
CONNECTIONS prior to the 
implementation of data entry 

changes to CCRS, and the ASP 
was not entered in CCRS, 

workers will not be able to go 
into CCRS and enter the 

information post 
implementation. 

 
For Advocates Preventive Only, 

the information that is 
completed within the FASP 

template will not be included in 
the CCRS.  

The purpose of supplying the assessment and service 
planning information to CCRS is not to keep it in synch with 
CONNECTIONS. Instead, the purpose is to keep the CCRS 
information going to other downstream systems such as 
AMS.  

Each night approved FASP’s and Plan Amendments, including changes to the PPG, and 
Anticipated Completion Date and/or Program Choices recorded in CONNECTIONS from the last 
five business days will be sent from the OCFS Data Warehouse to CCRS. If there is an open 
CCRS case the system will compare the FASP approval date to dates and plan type in CCRS.  
If the information in CONNECTIONS is newer, it will add a new Assessment Service Plan to 
CCRS. If the CCRS Plan Type and Date match the information in CONNECTIONS and there 
are changes in the PPG, Anticipated Completion date and/or the Program Choice in the 
CONNECTIONS record, then the record in CCRS will be updated with the new information.  

If the case has not been opened in CCRS the OCFS Data Warehouse will attempt to send the 
information for five business days.  After that, no attempts to send information will be made until 
another FASP or Plan Amendment is approved or additional changes to PPG, Anticipated 
Completion Date and/or the Program Choices are made. Therefore, if WMS and CCRS opening 
is delayed and an initial and/or comprehensive FASP is done and approved prior to opening the 
CCRS case, those FASPs will not be sent to CCRS.  Once the CCRS case is open, the next 
FASP to be approved will be updated in CCRS. In addition, if the PPG, Anticipated Completion 
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Date and/or Program Choice are modified and there is an existing approved FASP in 
CONNECTIONS, the information will be updated in CCRS.  Please note that if the case was not 
opened in CCRS within five business days of the FASP approval, CCRS Service Plans will not 
cue up to be entered in sequential order. Again, the goal of this change is to eliminate 
redundant procedures, not to keep CCRS and CONNECTIONS in synch. 

The CCRS Caseload Report will continue to exist. If there is a Case Planner assigned to a case 
in CONNECTIONS, CONNECTIONS will look in the Staff Detail window to determine if a valid 
CCRS agency/unit/worker code exists for that person. If one exists it will be sent to CCRS to aid 
in the sort of the CCRS Caseload Report.  

Online Help 

CONNECTIONS Online Help feature provides descriptions for various windows, as well as step-
by-step instructions for common tasks. You can access Online Help at any time, from any 
window in CONNECTIONS by clicking on the Help menu or pressing the F1 key on your 
keyboard. 

The Contents, Index and Search tabs in Online Help allow you to search for and navigate to 
the topic(s) you need help on. 

 

Step-by-Step: 
Accessing Online Help 

1 Click on the Help menu on the CONNECTIONS Toolbar. 
The following list of commands displays: 

A table of contents for the help facility with links to major sections. Contents 
Step-by-instructions to help you complete tasks using 
CONNECTIONS.  

How Do I? 

Descriptions of windows in CONNECTIONS, along with information on 
various fields. 

Window 
Descriptions 

Online OCFS policy handbooks (under revision). DSS Policy 
Window description help for the window you are on. Help On This 

Window 
Instructions on how to use the help functionality.  Help for Help 

About 
CONNECTIONS 

Information about the current CONNECTIONS version and build. 

2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window, 
you will see additional buttons and menus. Use the Search button to search for 
specific information in the Help function and use the Back button to return to 
windows you have just visited in Help. The Glossary button opens a list of important 
CONNECTIONS terms and the Print button allows you to print Help information. 
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3 When you are done reviewing information in Help, close each Help window by 
clicking on the Close button ( ) in the top right corner of the window. 
The system returns to the window you were using when you accessed Help. 
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Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff is available to 
answer basic questions related to your equipment, or to solve problems you are having with the 
CONNECTIONS application. If they cannot solve your problem, they will record your information 
and forward it to others who can. 

Your agency may have procedures in place for contacting the Enterprise Help Desk. Check with 
your supervisor before you call. 

The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The telephone number 
is: 

1-800-NYS-1323 
(1-800-697-1323) 

When you call the Enterprise Help Desk with a problem, you will be given a ticket number to use 
for tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Enterprise Help Desk. 

OCFS CONNECTIONS Intranet Site 
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site 
(http://ocfs.state.nyenet/connect/). The intranet site contains a wealth of information related to 
various aspects of CONNECTIONS, including training schedules, Alerts and Notices, Step-by-
Step Guides (including the CONNECTIONS Case Management Step-By-Step Guide), Job Aids 
and Frequently Asked Questions (FAQs). 

 

Step-by-Step: 
Accessing the OCFS CONNECTIONS Intranet Site 

1 From your local desktop, double-click on the Internet Explorer icon. 

2 If the browser does not display the OCFS intranet site automatically, enter 
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on 
your keyboard. 
The OCFS intranet home page displays. 

3 Click on the CONNECTIONS link. 
The CONNECTIONS home page displays. 

4 Click on a topic to access information. 
For access to various Step-by-Step Guides and Job Aids, click on the Step-by-
Step/Job Aids/Tips link. 

5 To close Internet Explorer, click on the File menu and select Close. 
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Appendix A:  
CCRS Mapping Chart 
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CCRS Mapping Chart 
CCRS Code # CCRS Component CONNECTIONS Component CONNECTIONS Location Mapping 
36-281 PLAN TYPE  

 A – 30 Day Initial Initial FASP FASP Tree  
 B – 90 Comp Comp FASP FASP Tree  
 C – 6 month 

Reassessment 
Reassessment FASP FASP Tree Note: the first Reassessment 

due in CONNECTIONS is 210 
days from the CID, not 6 
months. 

 P – Plan Amendment Plan Amendment FASP Tree  
 X - Correction No corresponding value 
36-280 Version/Cycle CCRS Version/Cycle includes the plan type and how many updates (cycles) to that version there 

are. There is no corresponding “cycle” in CONNECTIONS. Once a plan is approved it is frozen 
(unable to be modified). 

36-282 Plan/Date Date of the Plan FASP tab  
36-204 CHILD NEED  
 01 – 71 Service Need Code (Same values 

as CCRS) 
Service Plan/ Service Needs  

36-264 CHILD STATUS  
 A – Service Not 

Available 
Service Not Available Service Plan/ Service Needs  

 B – Service Refused Service Refused Service Plan/ Service Needs  
 C – Service planned Service planned Service Plan/ Service Needs  
 D – Service Planned – 

Waiting Opening 
Service Planned – Waiting 
Opening 

Service Plan/ Service Needs  

 E – Service Being 
Provided 

Service Being Provided Service Plan/ Service Needs  
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CCRS Code # CCRS Component CONNECTIONS Component CONNECTIONS Location Mapping 
36-205 FAMILY NEED  
 01 – 71 Service Need Code (Same values 

as CCRS) 
  

36-266 FAMILY STATUS See child status   
36-231 SVC PGM CHOICE  
 A – Preventive (non-

mandated) 
Preventive (non-mandated)   

 B – Preventive 
(mandated) 

Preventive (mandated)   

 C - Placement Placement   
 D - Protective Protective   
 No corresponding value Non-LDSS Custody*  Map Non-LDSS custody to 

mandated preventive in CCRS 
36-201 PERM PLN GOAL Permanency Planning Goal   
 01 – Discharge to 

Parents/ 
Legal Guardian 

Return to Parent (Parent or Non-
Parent Caregiver) 

Tracked Children Detail 
window 

 

 02 – Discharge to 
Other Primary 
Resource Person 

Referral for Legal 
Guardianship/Custody (Relative 
or Non-Relative) 

Tracked Children Detail 
window 

 

 03 – Discharge to 
Independent Living 

Place in another planned living 
arrangement - Discharge to 
Independent Living 

Tracked Children Detail 
window 

 

 04 – Discharge to 
Adoption 

Placement for Adoption Tracked Children Detail 
window 

 

 05 – Discharge to Adult 
Residential Care 

Place in another planned living 
arrangement – Discharge to Adult 
Residential Care 

Tracked Children Detail 
window 
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CCRS Code # CCRS Component CONNECTIONS Component CONNECTIONS Location Mapping 
36-201 PERM PLN GOAL Permanency Planning Goal   
 06 – Prevent 

Placement 
Prevent Placement Tracked Children Detail 

window 
 

 07 – Prevent Return to 
Placement 

Prevent Return to Placement Tracked Children Detail 
window 

 

 10 – Independent 
Living-Unaccompanied 
Refugee Only 

Place in another planned living 
arrangement – Independent 
Living-Unaccompanied Refugee 
Only 

Tracked Children Detail 
window 

 

 11 – Protect Child Protect Child Tracked Children Detail 
window 

 

 12 – Discharge to 
Relative-Other Than 
Parent/Guardian/Primar
y Resource Person 

Placement with a fit and willing 
Relative (Non-Guardianship/Non-
Custody) 

Tracked Children Detail 
window 

 

 No corresponding value Reunite with Parent* Tracked Children Detail 
window 

Map Non-LDSS Custody PPG 
to prevent placement in CCRS 

 No corresponding value Legalize Living Arrangement with 
Relative/Resource* 

Tracked Children Detail 
window 

Map Non-LDSS Custody PPG 
to prevent placement in CCRS 

 No corresponding value Permanent Living Arrangement 
(Non-Guardianship/Non-
Custody)* 

Tracked Children Detail 
window 

Map Non-LDSS Custody PPG 
to prevent placement in CCRS 

36-203 SET DATE PPG effective date Tracked Children Detail 
window 

 

36-202 ANTICIPATED DT Anticipated Completion Date Tracked Children Detail 
window 

 

36-107 DST/AGY PLN RSP Agency of the Case Planner Staff detail,  Assigned 
Workload, Assign window 
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CCRS Code # CCRS Component CONNECTIONS Component CONNECTIONS Location Mapping 
36-601 AUTH AGENCY  
36-133 AGENCY UNIT 

36-134 AGENCY WORKER 

The nine digit Agency/Unit/Worker code in WMS and CCRS is matched to the Person Identification 
Number (PID) in CONNECTIONS and displays on the Staff Detail window. 

36-118 WORKER FUNCTION  
 C - Child Worker Caseworker Assign window, Assigned 

Workload 
 

 J – CPS Monitor CPS worker/monitor Assign window, Assigned 
Workload 

 

 M – Case Manager Case Manager Assign window, Assigned 
Workload 

 

 P – Case Planner Case Planner Assign window, Assigned 
Workload 

 

 All other values No corresponding value  Map to Caseworker 
36-268 DT ASP COMPLETE Date FASP approved FASP tree  
36-348 TRANS INPUT DT Date FASP approved 
24-901  ARCHIVE IND 
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